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Brief Introduction

SenseCAP Indicator is a 4-inch touch screen driven by ESP32 and
RP2040 dual-MCU and supports Wi-Fi/BLE/LoRa communication. It
is a fully open source powerful loT development platform for

developers. One-stop ODM Fusion service is also available for
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customization and quick scale-up.

Product Video. https://youtu.be/I0OdI5_MGbCw
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Introduction

SenseCAP Indicator is a 4—inch touch screen driven by ESP32 and RP2040 dual-MCU and
supports Wi-Fi/BLE/LoRa communication.

The board comes with Type-C and Grove interfaces, supports ADC and IIC transmission

protocols, and can easily connect to other peripherals with rich GPIOs.

SenseCAP Indicator is a fully open source powerful loT development platform for
developers. One-stop ODM Fusion service is also available for customization and quick

scale-up.

Features

® Dual MCUs and Rich GPIOs: Equipped with powerful ESP32S3 and RP2040 dual

MCUs and over 400 Grove—compatible GPIOs for flexible expansion options.

® Real-time Air Quality Monitoring: Built—in tVOC and CO2 sensors, and an external



Grove AHT20 temperature and humidity sensor for more precise readings.

® Local LoRa Hub for loT Connectivity: Integrated Semtech SX1262 LoRa chip (optional)
for connecting LoRa devices to popular loT platforms such as Matter via Wi-Fi,

without the need for additional compatible devices.
® Fully Open Source Platform: Leverage the extensive ESP32 and Raspberry Pi open
source ecosystem for infinite application possibilities.

® Fusion ODM Service Available: Seeed Studio also provides one-stop ODM service for

quick customization and scale—up to meet various needs.

SenseCAP Indicator native firmware enables you to use it as a desktop air quality detector
or you could customize one of your own styles. There are built-in tVOCs and CO2 sensors,

and a Grove TH sensor is provided to connect externally to reduce heat interference to get

more accurate temperature and humidity results.

The embedded SX1262 LoRa module enables you to build the LoRa application and
connect your local LoRa sensors to the Cloud via Wi-Fi. For example, you could build a
LoRa hub device to connect your LoRa sensors to your smart home ecosystem to

implement Matter over Wi-Fi. In this way, the LoRa devices could be connected to the



Matter ecosystem via Wi-Fi, without the need to buy a new Matter—-compatible device.
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The software of SenseCAP Indicator is open source. Developers could create various loT

applications such as:

® Air Quality Monitor

® \Weather Station Display
® Sensor Data Dashboard
® Smart Home Assistant
® Mini Sensor Hub

® Stock Price Indicator

® Digital Alboum

® SOP Reminder

ChatGPT Indicator SOP Reminder On-site Alarm Digital Album




It can also be used to develop various exciting applications integrating with third—party
platforms, such as: AWS / ChatGPT / Matter / NodeRED / loTex ...
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Note: This sketch shows the development possibilities for the related loT

ecosystem, developers need to develop the firmware based on need.

SenseCAP Indicator is an interactive display and control terminal for various loT
applications. It provides developers with a powerful and interface-rich development
platform powered by ESP32-S3 and RP2040 dual-MCU.

Don't wait anymore, start your wonderful development journey with SenseCAP Indicator

now!

Hardware Version

The SenseCAP Indicator series offers four different versions: D1, D1S, D1L, and D1Pro.
Each version is designed to meet different application needs without any extra cost from

unnecessary hardware. Here are the differences between the versions:



Model
tVOC sensor
CO2 sensor

Grove TH Sensor
LoRa (SX1262)
Wi-Fi

Bluetooth

‘I ¥ % SENSECAP

D1 D1S DIL D1Pro
/ /

/ /

/ /

/ /

Toasch Screan F—

ESP3Z 4-Inch Open-saLTCE - B

Specification

Screen

Screen Resolution
Power Supply
Battery

Processor

3.95 Inch, Capacitive RGB Touch Screen

480 x 480 pixels
5V DC, 1A
N/A

ESP32-S3: Xtensa® dual-core 32-bit LX7 microprocessor, up to 240



Flash

External Storage
Wi—Fi

Bluetooth

LoRa(SX1262)

Sensors(Optional)

Buzzer

MHz
RP2040: Dual ARM Cortex—MO+ up to 133MHz
ESP32S3: 8MB
RP2040: 2MB
Support up to 32GB Micro SD Card (not included)
802.11b/g/n, 2.4GHz
Bluetooth 5.0 LE
LoRaWAN/(G)FSK, 21dBm Max Transmitted Power
Sensitivity/-136dBm@SF12 BW=125KHz RX Sensitivity, Up to 5km
(depending on gateway antenna and environments)
Range: 0-40000ppm
Built—in CO2 (SCD41) Accuracy: 400ppm — 5000ppm
+(50ppm+5% of reading)
Built—-in TVOC (SGP40) Range: 1-500 VOC Index Points
Grove TH Sensor (AHT20) Sensor
External Temperature and
Range: -40 ~ + 85 C/+ 0.3 C; 0 ~ 100%

Humidity Sensor
RH/+ 2% RH (25 C)

MLT-8530, Resonant Frequency: 2700Hz



ODM Service

Note:

If you want to customize your own SenseCAP Indicator, Seeed Studio provides one-stop
ODM service for quick customization and scalp—up. Please contact iot@seeed.cc if you

have large quantity customization need.

With over 10 years of ODM & OEM experience, our engineers and product experts are
proficient in delivering customization service for popular open—-source hardware platforms,

such as: Raspberry Pi, NVIDIA Jetson, Beagleboard, ESP32, and more.

We are committed to assisting you at any moment and shortening your path from idea to

products for emerging AloT scenarios.

The Trustworthy Provider of
ODM Service for Open
Source Hardware Platforms

ence, our engineers and product experts are
rvice for popular open-source hardware

son, Beagleboard, and more.

t any moment and shortening your path from

arios.



https://www.seeedstudio.com/odm
http://iot@seeed.cc

Get Started with SenseCAP Indicator

Hardware Overview

Button

Grove(ADC) — | - Grove(lIC)

USB2.0 Type-C

Internal Button \
,— Anttenna Connector
(Reserved)

MicroSD Card Slot
(Up to 32GB)

USB2.0 Type-C

Button Function

Short press: Turn off /wake up the screen
Long press for 3s: Switch on/switch off the device

Long press for 10s: Factory reset



Grove Interfaces

There are two Grove interfaces for connecting Grove modules, providing more possibilities

for developers.

Grove is a modular, standardized connector prototyping system and a strong open source

hardware ecosystem. (Click Grove — Seeed Studio to learn more)

GROW YOURIDEA
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SX1262 LoRa Chip

The embedded SX1262 LoRa module enables you to build the LoRa application and
connect your local LoRa sensors to the Cloud via Wi-Fi. For example, you could build a
LoRa hub device to connect your LoRa sensors to your smart home ecosystem to
implement Matter over Wi-Fi. In this way, the LoRa devices could be connected to the

Matter ecosystem via Wi-Fi, without the need to buy a new Matter—compatible device.


https://www.seeedstudio.com/category/Grove-c-1003.html
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loT Sensor

System Diagram
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USB2.0 Type-C Pinout

A2 A3 Ad4 A5 AB A7 A8 A9 AlO AN Al2

Al
oo @} o [ o || o s oo
m saqu D- H D+ Hc:cz GND
B12 BN B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl

Note: A2, A3, A10, ATl, B2, B3, B10, B1l connect to RP2040 GPIO8, GPIO9, GPIOO, GPIO1, GPIO2, GPIO3, GPIO15, GPIO14

Native Firmware

SenseCAP Indicator native firmware enables you to use it as a desktop air quality detector,
just a few simple steps to enjoy.

3

Temperature

Humidity




Wi-Fi Configuration

Plug the 5V power adaptor into the USB type—-C power connector, the device will

power on automatically, then the display will show the WiFi setting page.

WiFi_001

WiFi_002
WiFi_003
WiFi_004
WiFi_005

WiFi_006

Select the WiFi you need, input the password and

connect.

WiFi_001
Input password

*****n*l WiFi_002

WiFi_003

WiFi_004
WiFi_005

WiFi_006




Data Viewing

® Home page

Including the time, date, location info.

Monday, 06/03/2023

® Sensor data

Built—in tVOC and CO2 sensors, and an external Grove AHT20 TH sensor for more precise

temperature and humidity readings.



Click the specified sensor to enter the detailed information page, and you can

choose to display the value of 24h or a week.

Temperature Humidity

Week

805ppm

3ppm

BO3ppm

T 50ppm

f02ppm




Setting

£ Setting

Date & Time

Display Setting

Brightness: Adjust screen brightness

Sleep Mode: Turn off the screen according to the interval you set

Brightness

Sleep Mode

After




Date & Time Setting

Time Format: You can set 24H or 12H format.

Time Auto Update/Zone Auto Update: When the device is connected to WiFi, it will

automatically obtain the corresponding time zone and date.

Date & Time

Time Format

Time Auto Update

Zone Auto Update

Manual setting: If the time obtained through the time zone cannot automatically

identify the winter time or device is offline, then you can manually set the time zone

Date & Time

Time Format

Time Auto Update

Zone Auto Update

Time Zone




Development Tutorial

ESP32 Firmware Flashing
Flash by Flash Download Tools (For Windows only)

® Step 1: Connect the device to your PC with the provided USB type-C cable.
® Step 2:Install the Flash Download Tools

Flash Download Tools for Windows

sh_download_tool_3.9.3 -

Share WView
» ThisPC » Downloads » flash_download tool 3.3 » v (V] © Search flash_download_toel_3.9.3
~
i Name Type Size
bin File folder
configure File folder
di_temp File folder
doc File folder
logs File folder
'l} flash_download _tool 3.9.3.exe Application 15,855 KB

® Step 3: User interface setting

Double—click the .exe file to enter the main interface of the tool.
Chip Type: ESP32-S3

WorkMode: Develop

LoadMode: UART

20


https://www.espressif.com.cn/en/support/download/other-tools?keys=&field_type_tid%5B%5D=842

57 DOWN...

ChipType:
WorkMode:

LoadMode:

® Step 4: SPI Download Tab Configure

Download the Esp32 firmware file.

Example—factory—indicator_terminal_demo.bin

components

ESP32-53

ESP8266
ESP32
ESP8285
ESP32-D2WD
ESP32-52

- examples 1 Seeed-Solution / sensecap_indicator_esp32  ruic
> #a console

- factory.

<> Code (@ issues [1 Pullrequests (D Actions [[] Projects (11 Wiki
B README.md

© Security [ Insights & Settings

{_psram_120m.patch

# main -  sensecap_indicator_esp32/ examples / factory /

@ Wuirgin23 init sak

[ LIGENSE

D README.md

3 README.md

Y idf_psram_120m.patch

Tndicator_terminal_demo.bin init sk

= README.md

Factory Bin
Thisis the first version of bin for factory finmware which is programmed by terminal_demo,

IDF Patch

% Editpins -

Go to file

Add file -

oo

The patch is intended to achieve best perfermance of RGB LCD by using Octal PSRAM 120MHz feature. Therefore, the examples can work
normally under the default LCD PCLK of 18 MHz. The patch can be applied in IDF master (commit id:f3159) by following commands:

Click "..." and select the .bin file, downloading addresses:

(0)0]

D History



https://github.com/Seeed-Solution/sensecap_indicator_esp32/releases/tag/v1.0.0

B ESP32S3 FLASH DOWNLOAD TOOL V3.9.4 — O x

| SPIDownload |

F\terminal_demo_v1.0.0.bin 0x0

ooooO000(

59999 H 9

SPIFlashConfig

SPI1 SPEED SPI MODE Detectedinfo
DoNotChgBin

(® 40MHz Oailo

LockSettings
O26.7MHz (O QOUT
O 20MHz

O80MHz O DOUT Default
O FASTRD

DownloadPanel 1

com: [ =
START STOP ERASE

BAUD: g21600 ~

® Step 5: SPI Flash Configure

SPI SPEED: 40MHz
SPI MODE: DIO

® Step 6: Download Panel Configure

COM: Check the ports on your Device Manage, the USB-SERIAL is the correct

one.

Baud: 921600(recommended value)

22



B EX®

v & DESKTOP-3078MDR

> i Audio inputs and outputs

> 8 Computer

5w Disk drives

> [l Display adapters

5 Ml Frmware

v [ Human Interface Devices
&, HID-compliant game controller
&, HID-compliant pen
s, HID-compliant touch screen
i HID-compliant vendor-defined device
{# HID-compliant vendor-defined device
i Microsoft Input Configuration Device
{# Oray VHID

> * IDE ATA/ATAP controllers

> E= Keyboards

5 ([ Miceand other pointing devices

> I Monitors

5 @ Network adapters

> 7 Print queues
5 [ Processors
> ¥ Software components

5> 1 Software devices

> # Sound, video and game controllers
> S Storage controllers

> im System devices

> § Universal Serial Bus controllers

® Step 6: Start Downloading

Imﬂil B

More Actions »

DownloadPanel 1

5 ESP3253 FLASH DOWNLOAD TOOL V3.9.4 -
SPIDownload |
-
o e .
m]
O
(m]
O .o
(m] - @
O .o
%ﬂuﬁ(onﬁg = =
SPISPEED  SPIMODE Detectedinfo
@aov:  OQo [4DoNotChgBin
0% Ooout LockSetings
Owvz  @oio | CombineBin |
e fj Ovour | oeaur |
Oms®

IDLE
S

T I COM: v
smRT | stop ‘ ERASE llowse
BAUD: o160

v,

Then click "START" to start the downloading.

[ ESP3253 FLASH DOWNLOAD TOOL V3.9.4

~
0x0
| v
SPIFlashConfig
SPISPEED SPI MODE Detectedlnfo
DoNotChgBi A
@4MHz  OQI0 E4DoNotChgBin
O267MHz O QouT LockSettings
O @00
Sl |
(O FASTRD
Y
DownloadPanel 1
START sTop ey <" |com34 |
v|

BAUD: | 921600

23



When it shows "FINISH", the flash has been completed.

® " ESP32S3 FLASH DOWNLOAD TOOL V3.9.4 = a X
| spiDownload
]
Fterminal_demo_v1.0.0.bin .. @ [0
O - |@
O @
O - |@
0O - |@
gl @
[} - @
[m] - @ \
SPIFlashConfig
SPISPEED  SPIMODE Detectedinfo
@4aMHz  OQO [ DoNotChgBin flash vendor
O27MHz O QouT LockSettings de
O2uMHz  @DIO CombineBin
O8MHz  ODouT e
OFASTRD
DownloadPanel 1
FlleH AP: 3485188DA97D STA: 3485188DA97C
BT: 3485188DA97E ETHERNET: 3485188DAJ7F
START SToP gase | o [com ad
BAUD: 921600 v

| ——

Flash by IDF

For Linux and MacOS: Standard Toolchain Setup for Linux and macOS

For Windows: Standard Setup of Toolchain for Windows

After you have installed the IDF environment, you can flash it by IDF.

24


https://docs.espressif.com/projects/esp-idf/en/latest/esp32s3/get-started/linux-macos-setup.html
https://docs.espressif.com/projects/esp-idf/en/latest/esp32s3/get-started/windows-setup.html

esptool.py write_flash 0x@ terminal_demo_v1.0.0.bin

also you can build, flash and monitor the project.

cd <sdk>/examples/terminal_demo/

idf.py -p PORT build flash monitor

RP2040 Firmware Flashing

Flash by .uf2 file

® Step 1: Connect the device to your PC

Long press this internal button, then connect the device to your PC by the provided

USB type-C cable, release the button once connected.

® Step 2: Firmware Flash

After the connection is successful, your PC will show a disk.

25



200 Jessie ff] MacBook Air

£

- Yinidi] > B RS

IR B \acinioch 1D
> B RPI-RP2

config
£@\
T&

iCloud =&
71 JessiefMa...
y RPI-RP2
D M

Download rp2040 uf2 ,copy the .uf2 file in the firmware package to the disk, then

the disk will log out.

The upgrade will run automatically.

L N RPI-RP2

-1
BirfEr B INDEY HTM

RIFEERF M INFO_UF2.TXT
config

£H

TH

7 iCloud =i
Jessief Ma...
& RPI-RP2 &

o M

Flash by Arduino IDE

® Step 1: Install Arduino IDE

Arduino IDE

26


https://github.com/Seeed-Solution/sensecap_indicator_rp2040/releases/download/v1.0.0/terminal_rp2040_v1.0.0.uf2
https://www.arduino.cc/en/software

® Step 2: Add the Raspberry Pi Pico Board

Open your Arduino IDE, click on Arduino > Settings, and copy the below URL
to Additional Boards Manager URLs:

https://github.com/earlephilhower/arduino—pico/releases/download/global/pac

kage_rp2040_index.json

Arduine  File

About Arduino main | Arduino 1.8.19

Settings...

Hide Arduino
Hide Others
Shaw All

Quit Arduino

8 Sketchbook location:
9 #include <Mire.h>
10

JUsers [jessie/Documents {Arduino Browse
11 #include <SPI.h>
12 #include <SD.h> Editor language: English (English) B (requires restart of Arduina)
3
4 #include <PacketSerial.h> Editor font size: 12
16 SensirionI2CShtdx shtdx; Interface scale: Automatic 100 % (requires restart of Arduino)
7 SensirionI2CSgpdd sgpad;
5 SensirionI2CScdex scddx; Theme: Default theme [  (requires restart of Arduino)
a
20 Adafruit BMP3XX bmp; Show verbose output during: compilation upload
21
22 VDCGasIndexAlgorithm voc_algorithm; Compiler warnings: None B
23
4 PacketSerial myPacketSerial; Display line numbers Enable Code Folding
25 .
@ Verify code after upload Use external edit
26 String SDDataString = *°; & ety o fiupd shiatatln
7 @ Check for updates on startup Save when verifying or uploading

8 Use accessibility features
29 #define PKT_TYPE_SENSOR_SCD41_C0Z @XBZ

30 2 |Additional Boards Manager URLs: hower/arduino-pico/releases/download/ global/package_rp2040_index json | |5
31 #dafine PKT_TYPE_SENSOR_SHTAL TEMP @XB3 e

32 ddefine PKT_TYPE_SENSOR_SHT4L_HMIDITY € More preferences can be edited directly in the file

33 #dafine PKT_TYPE_SENSOR_TVOC_INDEX OXES jessie/Lil i xt

3

35 void sensor_data_send¢ uintd_t type, Flog (edit only when Arduina is not running)

e

7 uinté_t databuf[32] - {o}; oK Cancel

3 data_buf[8] = type;
=] et e

Anba WAEFIT Rdaka AN

Click on Tools > Board > Board Manager.

Arduino  File Edit Sketch | Tools  Help G ® % - > 0 R WedJsn 18

Auto Format main | Arduino 1.8.19

1 #include <Arduino.hs

2 #include <SensirionI2CShtax.h>

3 #include <SensirionI2CSgpdd.h-

4 #include <SensirionI2CScddx. hi-

5 $iilode AdFrUIESHEor o WIFI101/ WIFININA Flirmware Updater
6 #include “Adafruit_BMPIXX. R

7 #include <VOCGasIndexhlgorthn, RECECIREEERE LR R Sy Rk Boards Manager...

8 Role: "Master" iEE— .
9 # < % rauine Boards

19 Hrclige Atese Cache: "Enabled™

11 #include <SPLh» CPU Speed: 120 MHz (standard)"
£ pineluge <0l Optimize: "Small (-0s] (standard}”

3
4 #include <PacketSerial hs '50 MHz (standard)”

Seeed SAMD (32-bits ARM Cortex-MO+ and Cortex-Md) Boards >

© SensirionI2Cshtax shtdx; ot
Sensirion12CSgpsd sgpd: DenRgs

12 SensirionI2CScddx scdéx; TXRX LED: "On"

9

Port: *fdevjcu.usbmademi3201*

20 Adafrui ;
20 Mafruit BIPIEX bnp; e

22 VDCGas IndexAlgorithm voc_algorit)
- pialy Programmer

24 PacketSerial myPacketSerial; Burn Boatloader
s

26 String SDDataString =

28
25 #define PKT_TYPE_SENSOR_SCD41 COZ @XBZ

30

31 édefine PKT_TYPE_SENSOR_SHTAL TEMP OXB3

32 #define PKT_TYPE_SENSOR_SHT41 HLMIDITY @Xg4

33 #define PKT_TYPE_SENSOR_TVOC_INDEX @XBS

35 void sensor_data_sendC uint8_t type, float data)
36 {

37 wint8_t data buf[32] = {0};
3t databuf[e) - type;

|
Search and install "Raspberry Pi Pico/RP2040" in the Boards Manager

27



@ @ Boards Manager

Type All [Raspberry Pi Pico/RP2040

~Raspberry Pi Pico/RP2040

by Earle F. Philhower, III

Boards included in this package:

Raspberry Pi Pico, Raspberry Pi Pico W, 0xCB Helios, Adafruit Feather RP2040, Adafruit Feather RP2040 SCORPIO, Adafruit ItsyBitsy RP2040,
Adafruit QT Py RP2040, Adafruit STEMMA Friend RP2040, Adafruit Trinkey RP2040 QT, Adafruit MacroPad RP2040, Adafruit KB2040, Arduino
Nano RP2040 Connect, BridgeTek IDM2040-7A, Cytron Maker Nano RP2040, Cytron Maker Pi RP2040, DatanoiseTV PicoADK, DeRuiLab
FlyBoard2040Core, DFRobot Beetle RP2040, ElectronicCats HunterCat NFC RP2040, ExtremeElectronics RC2040, iLabs Challenger 2040 LTE,
iLabs Challenger 2040 LoRa, iLabs Challenger 2040 SubGHz, iLabs Challenger 2040 WiFi, iLabs Challenger 2040 WiFi/BLE, iLabs Challenger NB
2040 WiFi, iLabs Challenger 2040 SD/RTC, iLabs Challenger 2040 NFC, iLabs RPICO32, Melopero Cookie RP2040, Melopero Shake RP2040,
nullbits Bit-C PRO, Pimoroni PGA2040, Solder Party RP2040 Stamp, SparkFun ProMicro RP2040, SparkFun Thing Plus RP2040, uPesy RP2040
DevKit, Seeed XIAO RP2040, VCC-GND YD RP2040, Viyalab Mizu RP2040, Waveshare RP2040 Zero, Waveshare RP2040 One, Waveshare
RP2040 Plus 4MB, Waveshare RP2040 Plus 16MB, Waveshare RP2040 LCD 0.96, Waveshare RP2040 LCD 1.28, WIZnet W5100S-EVB-Pico,
WIZnet WizFi360-EVB-Pico, WIZnet W5500-EVB-Pico, Generic RP2040.

More Info

2.7.1 Install

~[DEPRECATED - Please install standalone packages] Arduino Mbed OS Boards -

by Arduino DEPRECATED
Boards included in this package:
Arduino Nano 33 BLE, Arduino Nano 33 BLE Sense, Arduino Nano RP2040 Connect, Arduino Portenta H7, Arduino Edge Control, Raspberry Pi

Dica Alials €. MC Acdiine lisla \iiol

Close

® Step 3: Add Libraries

Download these libraries we need:

Serial communication protocol

SGP40 TVOC sensor library

Transfer index library: Sensirion Gas Index Algorithm

SCD41 CO2 sensor library

AHT20 temperature and humidity sensor libray

Sensirion Arduino Core library

Navigate to Sketch —> Include Library —> Add .ZIP Library, then select the libraries

you download.
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https://github.com/bakercp/PacketSerial
https://github.com/Sensirion/arduino-i2c-sgp40
https://github.com/Sensirion/arduino-gas-index-algorithm
https://github.com/Sensirion/arduino-i2c-scd4x
https://github.com/adafruit/Adafruit_AHTX0
https://github.com/Sensirion/arduino-core/

& Arduino File Edit Sketch

1 #include <Arduino,h>
2 finclude <SensirionI2C tch Folder oy

3 #include <Sensirienl2C e

Include Librar

4 #include <SensirionI2C L Ethernet
5 #include <Adafruit SensiCElils
© #include "Adafruit BMPIXXT

7 #include <VOCGasIndexAlgorithm b GSM
LiguidCrystal

Robot Control

Firmata

8
9 Finclude <Hire.h>
18

11 #include <SPLh> Rabot IR Remote.
12 #include <SD.h> Rabot Motar

13
14 include <PacketSerial.h»
15

16 Sensir{onI2CSht4x shtdx;
17 Sensirionl2(Sgpd® sgpd@;
18 SensirionI2CScddx scadx; TFT

Temboo

Stepper

v ——

2 F——
22 VOCGasTndextgoritn v.olgorithm; i

21 PacketSerial myPacketSerial; Adatruit AHT1O

2 Adafruit AHTXO

Adatruit BusiO

b3 Adafruit DMA neopixel lbrary
fiorinn IR TIRE SERIORSCUL C02, |t Adafruit NeoMatrix ZeroDMA library

31 #define PKT_TYPE_SENSOR_SHT41_TEMP @XB3 Adafruit TinyUSB Library

26 String SDDataString =
27

32 #define PKT_TYPE_SENSOR_SHTAL_HUMIDLTY @XB4 Arduino.son

33 #define PKT_TYPE_SENSOR_TVOC_TNDEX OXBS

e ArduinoOTA

35 void sensor_data_send( uinté_t type, float data) AudioButferManager
36 5

37 uintd_t date_buf(3Z] = {0}; E“:j :
35 dotobuf[a] - type; AR
i

ot burfTAT Rdnbn AN- Diskg1 LoRa-E5 library

EEPROM

® Step 4: Connect the device to your PC with the provided USB Typc-C cable.

® Step 5: Select the board

Tools > Board > Raspberry Pi PR2040 Boards > Raspberry Pi Pico

@

main | Arduing Raspberry Pi Pico

Raspberry Pi Pico W

<3

Adafruit Feather RP204

1 #include <Arduino.h> arial Mo Adafruit

2 #include <SensirionI2CShtdx. o %
3 #include <SensirionI2CSgpsd.h> rial Plotter

her RP2040 SC:
Adatrut lisyBitsy RP2040

4 #include <SensirionI2CScddx. he Adafruit QT Py RP2040

5 #include <Adafruit_Sensor.h> WIFI101/ WIFININA Firmware Updater
6 #include "Adafruit BMP3XX.h’

ire.h> Arduine AVR Boards >

8
9 #include
e o Raspberry Pi RP2040 Boards(27.1)
12 #include €. Programmer; “AVRISP mkil*
L Burn Boatloader
4 #includs <Packetserial.ho

16 SensirionI2CShtax shtdx;
SensirionI2(5gp4d 5gpad;
18 SensirionI2CScddx scod

19
20 Adafruit _BMPIXX bmp;

2

22 VD(GasIndexAlgori thm voc_algarthm; ExtremeEilectronics RC2040

Adafruit STEMN
7 #include <VOCGasIndexAl gort thm. S LA AT Boards Manager... Adafruit Trinkey RP2040 QT
8 Port: *fdev/cu.usbmadem13201" Adafrult MacroPad RP2040

Get Board Info Adafruit KB2040
<SPLh> Arduino Nano RP2040 Connect
BridgeTek IDM2040-74
Cytron Maker Nano RP2040
Cytron Maker Pi RP2040
DatanoiseTV PicoADK
DeRuiLab FlyBoard2040Core
DFRabot B
ElectronicCats HunterCat NFC RP2040

e RP2040

23 ILabs Challenger 2040 LTE

PacketSerial myPacketSerial;

z5 iLabs Challenger 2040 LoRa
26 String SODataString = *~; [Labs Challenger 2040 SUbGHz
7

iLabs Challenger 2040 Wi
79 #define PKT_TYPE_SENSOR_SCD41_C0Z @XBZ ILabs Challenger 2040

>l iLabs Challenger NB 2040 WiFi
ILabs Challenger 2040 SD/RTC

31 #define PKT_TYPE_SENSOR_SHT41_TEMP BXB3
32 #define PKT_TYPE_SENSOR_SHT41_HUMIDITY @XB4

33 #define PKT_TYPE_SENSOR_TVOC_INDEX X85 iLabs Challenger 2040 NFG
Eed ILabs RPICO32

35 void sensor_data_send{ uint8_t type, float data)
37 winté_t data buf[32] = {0};
38 data_buf[@] = type;

Port: Select the "usbmodem" one
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main | Arduino 1.8.18

age Libraries
L #include <hrduine.h> Sarial Moni

2 #include <SensirionT2CShtdx.hs
3 finclude <SensirionI2CSgpd8.h>
4 #include <Sensirionl2(Scddx.h>
5 Pinclude <hdafruit Sansor.h WIF101 | WiFININA Firmware Updater
6 Finclude "Adafruit BMPIXX.h™

7 #include <VOCGasTndexalgorithn, NGNS R R L

8 Flash Size: *2M8 {no FS)"

CPU Speed: "33 MHz"

11 #include <SPL.h> Optimize: *Small (-0s) (standard)*
1§ #include <50.h> RTTI: *Disabled”

Serial Plotter

8
9 #include <Hire h»
10

Stack Protector: "Disabled"

‘:4 #include <PacketSerial.h>
s C++ Exceptions: “Disabled"

e sy

18 SensirionI2CScdéx scadx; Dabug Level: “Non:

3 S8 Stack: "Pico SDK"

2 RS IERL e P Stack: “IPva Only*

22 VOCGasIndexAlgorithn voc_algori SEEEERELULLERLET LN

3 Port: */devjcu.usbmodem13201" =

Get Board Infa + [devjeuusbmodemi3201

[devfcu.usbserial-1310

24 PacketSerial myPacketSerial;

25
26 String Sbbatastring
” Programmer

[devicuwlan-debug

Burn Bootloader

28
29 #idefine PKT_TYPE_SENSOR_SCD41_CO%

#deFine PKT_TYPE_SENSOR_SHT41_TEMP QX8B3
32 #define PKT_TYPE_SENSOR_SHT41_HUMIDITY 0XB4
33 fidefine PKT_TYPE_SENSOR_TVOC_INDEX OXBS

4
35 void sensor_data_send( uintd_t type, float data)
36{

37 uints_t data_buf(32] = {o};

35 data_buf(a] - typ

® Step 6: Open the example code file
File > Open, then select the example code file (.ino file).

We provide an example code file, you can modify the code according to your

needs.

main | Arduino 1.8.19

1 #include
2 #include
3 #include <9
4 #include
5 #include
6 #include
7 #include

8
9 #include
0

11 #include <SPT.h>
12 #include <SD.h>

13
14 #include <PacketSerial.hs
15

16 SensirionI2CShtax shtdx;

7 Sensirionl2(Sgods sgpdd;
18 SensirionI2CScoéx SCddx;

-3
20 Adafruit_BMP3XX bmp;

;3 VOCGasIndexAlgorithn vo_algari th;
o1 N

f? String SDDataString = "°;

:

2z
29 #define PKT_TYPE_SENSOR_SCD41_(02 @xB2

30
31 #efine PKT_TYPE_SENSOR_SHTAL TEMP @XB3

wmewmae
® Step 7: Verify and Upload the file.
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main | Arduino 1.

main

1 #include <Arduino.hs>

2 #include <SensirionI2CShisx.h
#include <SensirionI2C5qpsd.h>
12 e

4 #include <Sen:
5 #include <Adafruit_Sensor.h>
6 #include "Adafruit BMPIXK_h
include <VOCGasIndex

gori

nclude <ire.hs

11 #include <SPL.h>
#include <D, ho

#include <PacketSerial.h>

CShtax shtdx;
T205gp4 sgpad;

sirionI2CScotn sedhnt

20 Adafruit_BHPIXX bmp;

gorithm voc_

PacketSerial myPacketSerial;

6 String SDDataString = "~

nie PKT_TYPE_SENSOR_SCD41_C0Z  @XBZ

e PKT_TYPE_SENSOR_SHT41_TEMP @XE3

TYDE CEMSNR CHTAT WIMTRTTY  Aves

y SO at version 2

oF

_d 0000 n.ino.elf

main | Arduino 1.8.19

clude <Adafruit_Sensar.h-
6 #include "Adafruit BMPIXK.h

7 #include <V0CGasIndexAlgorit

9 #include Hire.ho

clude <SPT.h>
12 #include <5D.h>

#include <PacketSeriol.h>
onI2CShtax shtax;

onT2(5gpad sgpid;
SensirionI2CScdde scdte;

gorithm vo

myPacketSerial ;

ring SDbataString = **;

#define PKT_TYPE_SENSOR_SCDA1 COZ @XBZ

1 #define PKT_TYPE_SENSOR_SHT41_TEMP @XE3

HAnFina DNT TVDE CEMEND CUTA1 WIMTATTY  AVEA

7.1/1ibrar;
p2040/2

's=@ main | Arduino 1.8.18

nclude <Arduin

nclude <Sen:

nclude <Mire,ho

11 #include <SPL.h>

2 #include <SD.

#include <PacketSerial.h>
bnT2CShtdx shidx

1205gp40 sgpa@
onI2(Scdax scdx

) Adafruit_BMPIXX bmp;

de

lgorithm vo

PacketSerial myPacketSerial;

6 String SDDataString = "™

x-al gori thn-m

dFat

Raspbery P Pico,



Resource

IDF Downloard: Standard Toolchain Setup for Linux and macOS

Standard Setup of Toolchain for Windows

SenseCAP Indicator ESP32 SDK. SenseCAP Indicator SDK for esp32

SenseCAP Indicator RP2040 Examples: SenseCAP Indicator examples for rp2040

32


https://docs.espressif.com/projects/esp-idf/en/latest/esp32s3/get-started/linux-macos-setup.html
https://docs.espressif.com/projects/esp-idf/en/latest/esp32s3/get-started/windows-setup.html
https://github.com/Seeed-Solution/sensecap_indicator_esp32.git
https://github.com/Seeed-Solution/sensecap_indicator_rp2040
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